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Installing OfficeTalk Version 1.51

OfficeTalk Version 1.51 is supplied on two disks or on CD ROM. 



To install OfficeTalk from disks: Insert Disk 1 into your 3.5in floppy disk drive and select Run from the File menu in the Program Manager (or the Start Menu in Windows 95). In the Command Line box type A:\SETUP (or B:\SETUP if your floppy drive is called B:).



To install OfficeTalk from CD ROM: Insert the CD ROM into your CD ROM drive and select Run from the File menu in the Program Manager (or the Start Menu in Windows 95). In the Command Line box type D:\OTALK\SETUP (assuming D: is the letter of your CD ROM).



�



Run dialog box in Program Manager



Then press OK or press ENTER on the keyboard. Wait a few moments while OfficeTalk Setup initialises. You will then see a Welcome dialog box.



�



Setup Welcome dialog box



Press �. OfficeTalk Setup will then ask you to supply a directory path for the OfficeTalk database directory. OfficeTalk suggests a possible directory path. Either accept this, by pressing � or enter another more suitable drive and path. 



�



OfficeTalk Database Path dialog box





Note:	The drive and directory path for your database files must be a network drive and directory to which everyone has READ, WRITE and DELETE access.



If you have entered a drive and path which either already exists or is invalid, then OfficeTalk Setup will prevent you from moving on, warning you that the path entered is not valid. Enter a valid path and then press �.
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OfficeTalk Message



When you have pressed �, OfficeTalk Setup will ask you to provide a directory path in which to install the OfficeTalk executable files. 
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OfficeTalk Executables Path dialog box



OfficeTalk Setup provides a default directory path, F:\OTALK. Either accept this, by pressing �, or enter a drive and path of your choice. If you enter a drive and path which either exists or is invalid, then, again, OfficeTalk Setup will prevent you from moving on, warning you that the path entered is not valid. 



Enter a valid path and then press �. When you press �, OfficeTalk Setup will copy across the application files.



If you are installing from disks, OfficeTalk will ask you for the location of the second part of the installation. If you are installing from CD ROM, the installation program will bypass this dialog box.
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OfficeTalk Setup dialog box



Remove the first installation disk and place the second disk in your floppy drive. Type in A:\ and press � EMBED PaintShopPro  ���. OfficeTalk will now complete the installation procedure.



When OfficeTalk has finished installing it will create a new Program Group and put the OfficeTalk application icon and the OfficeTalk Help icon into the group.
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OfficeTalk Program Group



OfficeTalk Setup will then inform you that it has installed OfficeTalk successfully. You are given the choice of running OfficeTalk straight away or returning to Windows.
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Successfully Installed dialog box



Note:	If OfficeTalk Setup fails then this is likely to be due to a lack of disk space on the drive to which you are installing the executables. Free up some space and try the installation procedure again.

�

R� XE "Running OfficeTALK for the First Time" �unning OfficeTalk for the First Time



Start up OfficeTalk by double clicking the left mouse button on the OfficeTalk icon in the OfficeTalk program group which has just been created. Initially, a database will not exist, so a New Workgroup dialog box will appear, prompting you to either create a new workgroup database or import an existing one.
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New Workgroup dialog box



Press the � button. OfficeTalk will then display a Workgroup dialog box. Fill out your company/workgroup name, location, phone and fax numbers. Press �.
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Workgroup dialog box



When you press OK, OfficeTalk will then prompt you for your own details by displaying a User dialog box. Enter your first name, your last name and a login name and, for now, press OK. You can come back and add further personal details later on.
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User dialog box





When you press OK, OfficeTalk will create the database and display the Supervisor Mode. You are now ready to start using OfficeTalk. 



The next stage is to setup OfficeTalk on every user’s workstation. Follow the steps in the section, Network Setup. After that, you may want to add further users.



Once a database has been setup and users have been defined, users will be able to use their workstations to log onto OfficeTalk.



N� XE "Network Setup" �etwork Setup



Once OfficeTalk has been installed from the installation disk, all other workstations may be Setup over the network using the NETSETUP utility. 



Note:	The Network Setup should only be run after the Supervisor has been established as a user in the system. This is because OfficeTalk treats the first person who runs the application as the initial supervisor.



Using File Manager, locate the newly created OfficeTalk directory (for example, F:\OTALK, or whatever you entered in the Database Path field in the SETUP program). Either double click on the file netsetup.exe or use the File/Run pull down menu and use Browse to locate netsetup.exe.
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Locating the NETSETUP.EXE application



When you run NETSETUP.EXE, OfficeTalk pops up an OfficeTalk Network Setup dialog box. 



�



�



OfficeTalk Network Setup



This dialog box offers you the option of running the executable files from the network or running them from the local drive. If you want to install the executable files locally, select the Copy and run locally radio button and enter a drive and path where you wish the executables to be copied to. OfficeTalk provides a default path (which is C:\OTALK). Press �. If you enter a drive or a 

path which either exists or is invalid OfficeTalk Network Setup will prevent you from moving on warning you that the path entered is not valid. Enter a valid path and then press �.



If you want to run the executable files from the network (the default), click on the Run executables from server radio button and press �.



When you press �, OfficeTalk Setup will copy across the application files, create a new Program Group and put the OfficeTalk application icon and the OfficeTalk Help icon into the group.



OfficeTalk Setup will then inform you that it has installed OfficeTalk successfully. You are given the choice of running OfficeTalk straight away or returning to Windows.
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Successful Installation dialog box



U� XE "Using SHARE and VSHARE.386" �sing SHARE and VSHARE.386



For OfficeTalk to run correctly the environment must be setup so that different users may share the same file. For this, you must run either SHARE.EXE from the DOS prompt before running Windows, or, provided that you are running Windows 3.11 in 386 enhanced mode and do not have any DOS applications which need SHARE.EXE, then you may instead have the following entry in your SYSTEM.INI file in the [386Enh] section:







device=vshare.386



It is recommended that you use VSHARE rather than SHARE, if possible. However if you are using a DOS program which relies on SHARE then you should still load SHARE. 



Note:	VSHARE is only supplied with Windows version 3.11. It is not supplied with Windows 3.1.



OfficeTalk Setup checks to ensure that you have the relevant line in your SYSTEM.INI file to run VSHARE. If you do not have the entry, OfficeTalk Setup will warn you that SHARE.EXE or VSHARE should be run prior to running OfficeTalk. If you plan to use SHARE.EXE, then this may 

be added as an entry in your AUTOEXEC.BAT file (before the win command). If you are running Windows in 386 Enhanced Mode and plan to use VSHARE then add the above entry into your 

SYSTEM.INI file in the [386Enh] section. Also check to ensure that VSHARE.386 is located in your Window’s SYSTEM directory.



L� XE "Logging on to OfficeTALK" �ogging on to OfficeTalk



To log on to OfficeTalk, first run the application by double clicking the left mouse button on the OfficeTalk program item.



�



OfficeTalk Program Item



The Login dialog box will appear. If you have logged on previously at the same workstation, then your login name will already be selected in the Login Name field. If not, either type in your login name or select it from the list.
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Login dialog box



Next, enter your password. When you were initially set up as a user, OfficeTalk defaults your password to exactly the same characters as your login name. For example, if your name was John �



Smith and your login name was JS then your password would also be JS. (Note that case sensitivity is important). You may change your password from the Login dialog box.

Note:	Case sensitivity is important in both the Login Name and Password fields.
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Selecting your login name from the pull down list



Once you have entered your password, press the � button, or, alternatively, press the ENTER key on the keyboard. OfficeTalk will then log you in. By default, when you log in, you enter Diary Mode. You may specify which mode to start in.





Some of our users have suffered the ultimate indignity of being locked out of the system simply because their network supervisor forgot their password. Please ensure that you have set two users as supervisors.
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How do I install OfficeTalk onto a peer to peer network?



Before starting the OfficeTalk installation in a peer-to-peer network environment such as Windows For Workgroups, a choice must be made as to which network machine will act as the 'OfficeTalk Server' (i.e. the machine on which the central OfficeTalk database resides).  This choice should be made based on the following considerations:-



This machine must be available whenever an OfficeTalk user wishes to access OfficeTalk.

It must have sufficient resources to hold the OfficeTalk database and meet the demands placed on it by the OfficeTalk users.



Having chosen a suitable machine, a decision must be made as to which drive and directory the OfficeTalk database will be created in.  This choice should be made based on the following considerations:-



The OfficeTalk database must not reside in the root (top-level) directory of any drive.

Users must be given full access to the directory in which the OfficeTalk database resides and all of its subdirectories.



Having made the above decisions you can now start the OfficeTalk installation procedure.



On the machine designated as the OfficeTalk server perform the installation as described on pages 1-4. The database path requested by the installation program is the path decided above.  The executable path requested by the installation program can be a different path to the database path if you wish to keep the OfficeTalk data files separate to the OfficeTalk program files.



Having successfully completed this stage of the installation you must now ensure that the above directories can be accessed by any of the other machines on the network. How to do this is dependant on the type of peer-to-peer network used (e.g. how to share directories and how to connect to remote directories will be discussed in your network manuals).



The next stage of installation must be performed on each of the machines that will be running OfficeTalk excluding the OfficeTalk server.  Perform the network setup as described on pages 5-6. The network setup will ask whether to copy the OfficeTalk executables locally or run them from the server. It is recommended that the executables are run from the server as this will greatly ease the upgrade process in the future.



OfficeTalk should now be installed and ready to use.�



How do I install OfficeTalk onto a Novell Network?



Before starting the OfficeTalk installation in a Netware environment if multiple Netware servers exist, a choice must be made as to which network server will act as the 'OfficeTalk Server' (i.e. the machine on which the central OfficeTalk database resides).  This choice must be made as OfficeTalk does not support multiple servers in the current release.  This choice should be made based on the following considerations:-

Any network node requiring access to OfficeTalk must be able to connect to the machine designated as the OfficeTalk Server.

It must have sufficient resources to hold the OfficeTalk database and meet the demands placed on it by the OfficeTalk users.

Having chosen a suitable server (e.g. SERVER1) a decision must be made as to which network volume (e.g. ADMIN:) and directory (e.g. \OTALK) the OfficeTalk database will be created in.  This choice should be made based on the following considerations:-



The OfficeTalk database must not reside in the root (top-level) directory of any volume however the OfficeTalk directory can reside in the top-level.

Users must be given Read, Write, Create, Erase, Modify and File Scan rights to the directory in which the OfficeTalk database resides and all of its subdirectories.

All machines requiring access to OfficeTalk must have a network mapping to the volume containing the OfficeTalk database (e.g. DRIVE Q: =SERVER1\ADMIN:   \OTALK).



Having made the above decisions you can now start the OfficeTalk installation procedure.

From a machine with a suitable network mapping perform the installation as described in the OfficeTalk evaluation system manual pages 1-4. Using the example we have demonstrated so far the database path requested by the installation program would be Q:\OTALK.  The executable path requested by the installation program can be a different path to the database path if you wish to keep the OfficeTalk data files separate to the OfficeTalk program files.

The next stage of installation must be performed on each of the machines that will be running OfficeTalk excluding the machine used in step 6 above.  Perform the network setup as described on pages 5-6. The network setup will ask whether to copy the OfficeTalk executables locally or run them from the server. It is recommended that the executables are run from the server as this will greatly ease the upgrade process in the future.

OfficeTalk should now be installed and ready to use.





Installing and running OfficeTalk with other Btrieve applications



If you run any other Btrieve applications please contact our technical support department for further information. If you are unsure whether or not you are running any other Btrieve applications use the File\Search in File Manager to search for the file WBTRCALL.DLL. If you do locate copies of this file please call our technical support staff on 0181 423 9434.

�



R� XE "Registering OfficeTALK" �egistering OfficeTalk



When you first log onto OfficeTalk, you have 70 days to trial OfficeTalk. At the end of the 70 day trial OfficeTalk will cease working. Any time during the 70 days, you can purchase your licenses from Sareen Software Plc by following the instructions below. OfficeTalk will inform the Supervisor after 40 days that the license is due to expire in 30 days. The Supervisor will then be informed on a regular basis of the number of days before the license is due to expire.



Important:     Once you register your copy of OfficeTalk your trial period will end



Registration Checklist



Full instructions for registering OfficeTalk are below and in the License\Obtain Keycode and Order Info menu option in Supervisor mode. To ensure a minimum of delay please observe the following points :



When entering your workgroup name please ensure that there are no spaces at the beginning and end of the workgroup name



� EMBED PaintShopPro  ���  ü

� EMBED PaintShopPro  ���      û



Ensure the license number is correct.

When sending in a Keycode Request form please indicate how you would like to pay for the user(s). If you are faxing the form please attach either an official Purchase Order or your credit card details. If you are posting the form please attach either an official Purchase Order, credit card details or a cheque.



Without a form of payment we are unable to process any keycode requests





Registering your OfficeTalk Evaluation System



To register OfficeTalk and receive the product-enabling keycode, do the following:



Login as a supervisor and enter Supervisor Mode. Choose Obtain Keycode from the License menu.
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License menu



A Register OfficeTalk dialog box will appear.
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Obtain Keycode dialog box



Press the � button. The Workgroup Name dialog box will appear.
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Workgroup Name dialog box



Ensure that the Workgroup Name is correct. This is important since the keycode that you receive will be based upon this name and changing the Workgroup Name at some point in the future will invalidate the keycode.



Press the � EMBED PaintShopPro  ��� button. OfficeTalk will then prompt you for the number of users you require. Press OK.



Next enter your details or the details of the person to whom Sareen Software will communicate the product-enabling keycode. Do this by pressing the � button in the Register OfficeTalk dialog box. When you press this button the Contact Details dialog box will appear for you to enter the relevant details.
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Contact Details dialog box





When you have entered the relevant details, press �.

Next fill out any feedback that you have about the product by pressing the � button. When you press this button, a Feedback dialog box will appear:
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Feedback dialog box



Finally, press the � EMBED PaintShopPro  ��� button. This will print out a Registration Form. Fax this form through to Sareen Software (0181 423 9438). If you want to send your  keycode request form by E-Mail press the � EMBED PaintShopPro  ��� button. This will generate a text file. When sending your keycode request by E-Mail, please ensure the keycode form is part of the message body and not an attachment to the mail message. E-Mail this form to Sareen Software  (otsales@sareen.com). 



You will be given your keycode by fax, phone or E-Mail. Before entering the keycode please log everybody out of OfficeTalk. Use View\Who menu in Supervisor Mode to ensure everybody is logged out. Please ensure all remote users are logged on to the main database.



Next, you should enter the license details. Your license number will be on the fax with the keycode. Each license number is associated with a certain number of user licenses.



Bring up the Licence dialog box by selecting License from the License menu in Supervisor mode.



�
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Licenses dialog box



You can add a license by pressing the � button. Pressing this button will pop up a License dialog box.
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License dialog box



Enter the license number for this license and the number of users. Press OK. The license will now appear in the Licenses dialog box. You can edit or delete any entries in this dialog box using the � and � buttons.



Finally press � on the Licenses dialog box.



Bring up the Enter Keycode dialog box by selecting Enter Keycode from the License menu in Supervisor mode.
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License menu



Enter your keycode into the Keycode field in the Enter Keycode dialog box and press �. Note that OfficeTalk ignores the ‘-’ character, so you can use it to space the numbers for clarity.

�

�





Enter Keycode dialog box



When you press �, OfficeTalk will check that the keycode matches the Workgroup Name, the number of users and the license number. If the keycode is not correct, OfficeTalk will inform you of this by popping up the following message:
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OfficeTalk Warning



If you get this message, firstly ensure that you have typed in the keycode correctly into the keycode field. If no error was made typing in the keycode, check to ensure that you have not changed the spelling of the workgroup name since registering OfficeTalk. Also check to ensure that no licenses have been added or deleted from the License dialog box since you registered the product. If you still cannot find any reason why the keycode does not work contact Sareen Software.



If everything is OK then OfficeTalk will pop up the following message box:
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OfficeTalk Message



OfficeTalk will now be registered. OfficeTalk will remember your keycode. You should never change the workgroup name, license information or keycode unless you purchase further licenses in the future.



Choosing Licensed Users



During the 70 day Registration Period you may add up to 100 OfficeTalk users. When you register the product and obtain a keycode for a specified number of users, it is possible that there are more 

users than the number of user licenses that you have. For this reason, OfficeTalk lets you specify a subset of users who will become the actual users.





�

If you have more users than licenses, then when you first log on after entering the product-enabling keycode, OfficeTalk will warn you of this.
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OfficeTalk warning



OfficeTalk will then prompt you to specify the subset of actual users by popping up a Select Licensed Users dialog box.
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Select Licensed Users dialog box



Choose the users who you wish to license by selecting them from the Unselected list and pressing the � button. When you have chosen all the users, press OK. If, for example you have purchased 5 licenses but you have chosen more than 5 users then OfficeTalk will prevent you from continuing by issuing the following message:
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OfficeTalk Message



Remove some users from the Selected list and press OK. You must choose at least one supervisor user. If you do not, OfficeTalk will prevent you from moving on by issuing the following message:  You must select at least one supervisor.
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Backups



OfficeTalk allows users to perform personal and workgroup backups. 



It is essential that users perform daily backups as circumstances beyond the control of OfficeTalk can possibly corrupt data. Without backup data it may be impossible to restore OfficeTalk.



Personal Backups

Users are prompted every day as to whether they wish to make a personal backup. They are offered three options of Now, Later or Cancel. We advise all users to use this facility as it backups their diaries and task lists which can be restored at a later date.
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Personal Backup Dialog 



Workgroup Backups

This will backup all your OfficeTalk data into one file. To enable a Workgroup backup, go to the Supervisor mode and go to the Options\Workgroup Data Backup pull down menu. 
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Workgroup Data Backup dialog



OfficeTalk lets users specify who will perform the backup. Users can also decide whether the backup will be automatic or whether they wish to be prompted before each backup is made. The length of the backup will depend on the amount of data held in OfficeTalk.
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OfficeTalk Overview



The following pages provide a brief introduction to each module.



Supervisor Mode



Supervisor Mode lets you add users, resources, user groups, workgroup-wide projects and  planners, workgroup-wide task classifications and specific workgroup details such as public holidays, workgroup-wide task priority descriptions, backups and usual workgroup working hours. In addition to this, Supervisor Mode lets you define individual user’s access rights to projects, planners and other users’ diaries.





Diary Mode



The Diary Mode is used to keep appointments, task lists (to-do lists) and background activities for yourself and all the other users in your organisation. From within the Diary Mode you can view and update your own diary information. If you have the appropriate access rights, you can view and even update other users’ diary information. OfficeTalk also lets you keep diary information for resources such as meeting rooms, pool cars and other bookable items.



Planner Mode



The Planner Mode allows users to create planners, which are a way of planning and sharing long term information such as holidays and training courses. Planners contain planner bookings which are one or more days in duration. A good example of the typical use of a planner would be a holiday planner. A planner may be created which keeps the holiday commitments of the entire workgroup. This information will then be available to all OfficeTalk users for use in their own planning and scheduling.



Project Mode



The Project Mode is ideal for planning and monitoring projects within your organisation. A project consists of a group of project related tasks and a plan for when those tasks will be completed and by whom. Project tasks can be assigned to individual users using the OfficeTalk mail system.



Group Mode



The Group Mode is ideal for looking at the activities of a group of users and resources. There are two views in Group Mode, the table chart view which presents a group’s activities in a timetable format and the group chart view which represents a group’s activities in a chart format.
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Meeting Mode



The Meeting Mode lets you organise meetings simply and efficiently. From within Meeting Mode, you can check other users’ and resources’ availability, write meeting agendas, send out meeting invitations and monitor the replies. Meeting Mode works closely with the OfficeTalk mail system. 



Contact Mode



The Contact Mode provides a rich set of contact management features. Contact Mode lets you add contacts, schedule follow-up tasks, record conversations, define company and contact groups, print labels, export mail merge files to word-processors and a whole lot more.



Contact Mode contains several different views on your contact data. Company View shows company information, namely the site address and a list of employees (contacts) who work for the company. Contact View shows information specific to a particular contact, for example, the name and address of the company to which the contact belongs, if any, and the contact's home address, title, position etc. Documents can be created and archived against the relevant contacts and mail merges created using OfficeTalks contact groups.



The Directory View shows both company and contact information in a telephone directory format. 

Conversation View show conversations that you and other users have documented with contacts.



Mail Mode



The Mail Mode provides a very easy to use mail facility with most of the features that you would expect from a standalone mail package. In addition, OfficeTalk mail is both MAPI and VIM compliant which means that it will interface with Microsoft Mail™, Lotus cc:Mail™ and many other popular E-Mail packages. Users can send mail to individual users, groups, outside contacts and to public bulletin boards.  Documents and tasks can be mailed to users and their status tracked.



Notify Mode



Notify Mode lets you compose and send messages directly to other users’ screens. This may be considered a more urgent and intrusive form of E-Mail. Provided that the recipient is running OfficeTalk, regardless of what application the recipient is currently working in, any message received will appear over the top of all other windows, ensuring that they are made aware of the message.



Working Remote



This allows users to copy certain portions of the OfficeTalk database onto a local disk and continue using OfficeTalk as if you were connected to a shared database. This is extremely useful if you have a portable computer and spend most of the time away from the office, but still wish to benefit from the shared data offered by the main database.�



Automatic Document Creation, Archiving and Mail Merges



OfficeTalk V1.5 now allows you to link to any major word processor to create documents and archive them against companies and contacts already held in OfficeTalk’s central database.



Creating Document Templates



OfficeTalk uses both Rich Text Files (RTF) and Text Files (TXT) as templates for creating documents within your word processor. Before using OfficeTalk with your word processor, you will need to check that your word processor can load and open RTF and TXT files.



To associate your word processor with .RTF and .TXT files you will need to use File\Associate command in File Manager to check that RTF or TXT are associated with your wordprocessor. Type RTF or TXT in Files with Extension and Associate With will show which (if any) application is currently associated with RTF or TXT files. If your word processor is correctly associated press OK. If not, select your word processor from the Associate With and then press OK.
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Associate dialog box



If you are using Windows 95, use the View\Options meuu in Explorer and select the � EMBED PaintShopPro  ��� tab. Locate RTF or TXT from the Registered file types list. If the File types details box does not correspond to your word processor  press the � EMBED PaintShopPro  ��� button to change the association.



OfficeTalk lets you create a template for a Document which may then be sent to any contact or company held within the OfficeTalk database. Certain fields may be specified in the template which will be replaced by information relating to the contact or company selected. 



OfficeTalk lets you design document templates either as pure text files (with .TXT extensions) or as Rich Text Files (with .RTF extensions). The final size of the template file must not exceed 64k.



To create a Document template, use any word processor which supports either RTF format (for example Microsoft Word ™) or Text format (any word processor, including Notepad ™). Design the template (See Designing Document Templates page 21 for more information) and save the file into the _tmpltes sub directory of the OfficeTalk directory. It is important that you save the file into the _tmpltes directory so that other users may use your template.



The filename of the saved template may be any filename which has a .TXT or .RTF extension. 





Next, select Document Templates from the Edit menu in Contact mode. The Document Templates dialog box will appear. This dialog box shows a list of existing Document templates with buttons to create, edit and delete templates. Press � EMBED PaintShopPro  ��� to bring up the Document Template dialog box.
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Document Template dialog box



Give the new template a name and then, use the � EMBED PaintShopPro  ��� to search for the RTF template file that you created. By default, the template will be personal to you and only you will be able to see the template. You may make the template visible to all users by selecting the public radio button. Press OK to save the template.



Designing Document Templates



When creating Documents and mail merges, OfficeTalk takes a copy of the Document template and replaces one or more fields with information relating to you, the selected company and the selected contact. 



The following is a list of fields that OfficeTalk recognises. Note that case is important.



<@Company>	The selected company name. Valid only if a contact is not selected, blanked otherwise.

<@Contact>	The selected contact last name. Blanked if no contact selected.

<@User>	Your surname.

<@CompanyName>	The selected company name. Valid only if a contact is not selected, blanked otherwise.

<@CompanyDescription>	The selected company name and address1. Valid only if a contact is not selected, blanked otherwise.

<@ContactName>	The selected contact last name. Blanked if no contact selected.

<@ContactDescription>	The selected contact name (using contact name style). Blanked if no contact selected.

<@UserName>	Your surname.

<@UserDescription>	Your full name (using user name style).

<@UserLastName>	Your surname.

<@UserFirstName>	Your first name.





<@CompanyCreationDate>	The  date when the company record was created.

<@CompanyCreationTime>	The time when the company record was created.

<@ContactCreationDate>	The date when the contact record was created.

<@ContactCreationTime>	The time when the contact record was created.

<@UserCreationDate>	The date when your user record was created.

<@UserCreationTime>	The time when your user record was created.

<@CompanyAddress>	The company full address. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyAddress1>	The company address1 field. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyAddress2>	The company address2 field. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyAddress3>	The company address3 field. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyTown>	The company town/city field. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyCity>	The company town/city field. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyPostcode>	The company postcode. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyPhone1>	The company phone1 field. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyPhone2>	The company phone2 field. Valid only if a contact is not selected. Blanked otherwise.

<@CompanyFax>	The company fax field. Valid only if a contact is not selected. Blanked otherwise.

<@ContactAddress>	The contact full address field. This is the company address, if the contact belongs to a company. Otherwise it is the contact’s home address. Valid only if a contact is selected. Blanked otherwise.

<@ContactAddress1>	The contact address1 field. This is the company address1, if the contact belongs to a company. Otherwise it is the contact’s home address 1. Valid only if a contact is selected. Blanked otherwise.

<@ContactAddress2>	The contact address 2 field. This is the company address 2, if the contact belongs to a company. Otherwise it is the contact’s home address 2. Valid only if a contact is selected. Blanked otherwise.

<@ContactAddress3>	The contact address 3 field. This is the company address 3, if the contact belongs to a company. Otherwise it is the contact’s home address 3. Valid only if a contact is selected. Blanked otherwise.

<@ContactTown>	The contact town/city field. This is the company town/city, if the contact belongs to a company. Otherwise it is the contact’s home town/city. Valid only if a contact is selected. Blanked otherwise.

<@ContactCity>	The contact town/city field. This is the company town/city, if the contact belongs to a company. Otherwise it is the contact’s home town/city. Valid only if a contact is selected. Blanked otherwise.
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<@ContactPostcode>	The contact postcode field. This is the company postcode, if the contact belongs to a company. Otherwise it is the contact’s home postcode. Valid only if a contact is selected. Blanked otherwise.

<@ContactPhone1>	The contact phone1 field. This is the company phone1, if the contact belongs to a company. Otherwise it is the contact’s home phone1. Valid only if a contact is selected. Blanked otherwise.

<@ContactPhone2>	The contact phone2 field. This is the company phone2, if the contact belongs to a company. Otherwise it is the contact’s home phone2. Valid only if a contact is selected. Blanked otherwise.

<@ContactFax>	The contact fax field. This is the company fax, if the contact belongs to a company. Otherwise it is the contact’s home fax. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomeAddress>	The contact full home address. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomeAddress1>	The contact home address1 field. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomeAddress2>	The contact home address2 field. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomeAddress3>	The contact home address3 field. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomeTown>	The contact home town/city field. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomeCity>	The contact home town/city field. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomePostcode>	The contact home postcode field. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomePhone1>	The contact home phone1 field. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomePhone2>	The contact home phone2 field. Valid only if a contact is selected. Blanked otherwise.

<@ContactHomeFax>	The contact home fax field. Valid only if a contact is selected. Blanked otherwise.

<@ContactFirstName>	The contact’s first name. Valid only if a contact is selected. Blanked otherwise.

<@ContactLastName>	The contact’s last name. Valid only if a contact is selected. Blanked otherwise.

<@ContactPosition>	The contact’s position. Valid only if a contact is selected. Blanked otherwise.

<@ContactDepartment>	The contact’s department. Valid only if a contact is selected. Blanked otherwise.

<@ContactTitle>	The contact’s title. Valid only if a contact is selected. Blanked otherwise.

<@ContactCompany>	The company that the contact belongs to. Valid only if a contact is selected.

<@Date>	The current date.

<@Time>	The current time.
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<@ConversationSubject>	The Conversation subject record in Conversation Mode.



Certain fields are blanked if either a contact is not selected (in the case of some contact fields) and if a contact is selected (in the case of some company fields). In these cases, it is possible to supply defaults for the fields. For example, you might be mailing a set of companies, some of whom have contacts that may be addressed as Dear <@ContactFirstName> and others which do not have contacts that should be addressed Dear Sir/Madam. It is possible to provide this default by appending a colon directly after the field name, just prior to the closing field delimiter ‘>’. For example, to achieve the stated result, the greeting in the Document template would be as follows:



	Dear <@ContactFirstName: Sir/Madam>



An example of a Document template is as follows:





						Sareen Software Plc

						Bydell House

						Sudbury Hill

						Harrow-on-the-Hill

						Middx	HA1 3NJ

						

						<@Date>





<@ContactTitle> <@ContactFirstName> <@ContactLastName>

<@ContactCompany><@Company>

<@ContactAddress><@CompanyAddress>





Dear <@ContactTitle> <@ContactLastName:Sir/Madam>





If you have any further queries please do not hesitate to contact me



Yours sincerely





<@UserFirstName> <@UserLastName>





The above example uses the fields <@ContactAddress><@CompanyAddress>. The combination of these fields handles the case where you are writing a Document to a company rather than a contact. In such a case, the <@ContactAddress> will be blanked and the <@CompanyAddress> will be replaced. 
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Creating Documents



Once you have created a Document Template, the procedure for creating a letter or fax within your  word processor is as follows:



Within the Company or Contact view, select the company and/or contact to whom you wish to write the Document. If you wish to write to a contact in a company, highlight the contacts name. 



� EMBED PaintShopPro  ���



Select New Document from the Edit menu in Contact mode (alternatively press CTRL + W from within Contact mode). A New Document dialog box will appear showing who the Document is to. 
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New Document dialog box



Select the Document template required, enter a subject (or leave blank to get the Document template name as the default subject) and choose whether or not to add the Document as a conversation. If it is not added as a conversation, OfficeTalk will not record the Document anywhere else.

Press � EMBED PaintShopPro  ���. This will generate the Document and will load it into the relevant word processor. If you do not select Add as a Conversation OfficeTalk will ask you if you wish to save the file or discard it, after it has been loaded into the word processor.

Make any necessary changes to the Document and print/save as required.

Exiting the word processor will return you to OfficeTalk. 
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Note: If you leave the Store Document as Conversation Attachment unchecked, OfficeTalk will load the document into the word processor and dependant on your word processor, will either take you straight into the word processor or display the following dialog box.
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If the dialog box is displayed press ALT-TAB to switch to your word processor and print the document. If ALT-TAB does not switch you between applications, double click on the Control Panel icon located inside the Main Program group. Double click on the Desktop icon and ensure that � EMBED PaintShopPro  ��� is enabled. Once you have finished with the document and exit the word processor, you will be returned to OfficeTalk.





Creating Mail Merges



Once you have created a Document Template, the procedure for creating a mail merge is as follows:



Select Mail Merge from the Edit menu in Contact mode. The mail merge dialog box will appear:
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Mail Merge dialog box
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Select a Contact Group that you want to mail (for more information on Contact Groups contact Sareen Software and request the Creating Contact Groups document). Select Mail Companies and/or Mail Contacts depending upon whether or not you wish to mail either or both companies and contacts in the selected contact group. Select Mail Contacts  to mail to both the contact and company and Mail Companies to mail just the company .



Mail Contacts				Mail Company



Mr B Jones					

CTS Ltd					CTS Ltd 

23 South Walk				23 South Walk

London 					London

E14						E14



Select the Document template required, enter a subject (or leave blank to get the Document template name as the default subject) and choose whether or not to add the mail merge as a single conversation. You can add the mail merge as a single conversation by selecting the Add Conversation for Mail Merge check box. Additionally you can add the generated mail merge file as an attachment to the conversation by checking the Attach Mail merge File check box. If the generated file is not added as a conversation attachment, OfficeTalk will not record the generated file anywhere else. OfficeTalk also lets you create a conversation for each recipient of the mail merge. You can also choose whether or not you wish to attach the generated document and/or the original template file by checking either or both the Attach document template and  Attach mail merge file check boxes. 

Press OK. This will generate the mail merge as a single document and will load it into the relevant word processor. If you did not select to attach the generated mail merge file as an attachment to the conversation, OfficeTalk will ask you if you wish to save the file or discard it, after it has been loaded into the word processor. See Note on page 26.





Automatically Creating Conversations



When creating Mail Merges or single Documents to contacts and companies, OfficeTalk gives you the choice of adding the Document or mail merge as a conversation. When creating a Document, the conversation made will be linked to the relevant contact, company and user with date and time information filled in. The Document will appear as an attachment in the Conversation view. 



If you do not choose to store the created Document or mail merge as a conversation, then OfficeTalk will prompt you to keep or discard the generated Document or mail merge file.
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If you choose to keep the file, it will remain in the _Letters sub directory until you manually delete it. If you choose to discard the file, OfficeTalk will delete the file for you. Some word processors 
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will not let you delete the file while it is loaded in the word processor. If you do try, OfficeTalk will warn you that it could not delete the file. See Note on page 26.
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If you wish to discard the file, perform any word processing operations, such as printing the file, and then close file in the word processor. Then press Retry on the dialog box.



Using OfficeTalk with Specific Word Processors



OfficeTalk can launch and create documents within the current editions of all major word processors. 



Microsoft Word™ 6 and 7



Recommend using Rich Text Files 



Microsoft Wordpad ™



This is supplied with Windows 95 and will read Rich Text Files. You will need to exit WordPad after each letter is created as Wordpad is unable to handle multiple documents. If you create another document while Wordpad is open, another Wordpad session will be started.



Lotus Ami Pro™



Ami Pro 3.0 will not read RTF files due to a bug which has been corrected in Ami ProVersion 3.12. When you load a RTF file into Ami Pro, you will be prompted with the Import Options dialog box.
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Import Options dialog box



Select Ignore Styles and press OK. Ami Pro will then load the correct document. The same principle applies for mail merges.
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WordPerfect ™ 5.1

OfficeTalk is supplied with a standard letter (WPLetter.RTF)  and fax template (WPFAX.RTF) created in Word Perfect 5.1. These are located in the _tmpltes directory. You will need to use the 

Edit\Document menu in Contact Mode to load them into OfficeTalk (see page 20). When you load a RTF file into WordPerfect 5.1, you will be prompted with the following  dialog box
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Convert File Format dialog box



Press OK and the document will be loaded into WordPerfect. OfficeTalk is unable to generate mail merges into WordPerfect 6.0 and 6.1.



Word Perfect 6.1™ 



WordPerfect will load RTF files. When you load a RTF file into WordPerfect you will be presented with the Convert File Format dialog box. Press OK and WordPerfect will load the documents in. OfficeTalk is unable to generate mail merges into WordPerfect 6.0 and 6.1.
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Convert File Format dialog box



Windows Write



Windows Write will only load TXT files. When you load a TXT file, press Windows Write will prompt you as to whether you wish to convert the file. Press Convert and Windows Write will load the file.
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Conversion dialog box�

Working Remote and Document Creation.



OfficeTalk users can create and archive documents while remote. However document templates are not copied down when a user goes remote and the following  instructions will need to be followed if users wish to create and archive documents while remote.



Create a directory on the machine that you are using to work remote from and call it c:\remtempl.

Copy the templates you wish to use when working remote from your otalk\_tmpltes directory to your c:\remtempl directory.

Before you work remote, go to Contact Mode and select Document Templates from the Edit menu.

Add the templates by pressing the New button and specifying the path of the document as c:\remtempl\template name.  To avoid confusion between your ‘remote’ templates and those held on the main OfficeTalk, add (Remote) after the templates name. Ensure that the Personal radio button is selected. 
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Document Template dialog box



When the user works remote they will need to ensure that they have checked the Contact box i.e. � EMBED PaintShopPro  ���, otherwise the OfficeTalk address book will not be downloaded.

When the user works remote, they will be able to access the template stored in the c:\remtempl directory. If OfficeTalk reports that it cannot generate a valid document file, the user has tried to use a template that it stored in the otalk\_tmpltes directory rather than a template stored in the c:\remtempl directory.

When users select Update Main Database or Work Online, any documents created while working remote will be added to the main database.



�Integrating OfficeTalk and the Workgroup Internet Gateway



This process should only be attempted once the Workgroup Internet Gateway (WIG) has been installed and is operating correctly, either within the Microsoft Exchange Client (supplied with Windows 95), or the Microsoft Mail Client (supplied with Windows for Workgroups).



Enabling OfficeTalk to send and receive Internet Mail Via WIG 



Within OfficeTalk, go to the Mail Mode and select the Options\External Mail pull down menu. 
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External Mail dialog box



Click once on the Turn on MAPI Support checkbox and Use WIG for sending Internet Mail.

If you are running Windows 95, enter your Microsoft Exchange profile name, by default this is MS Exchange Settings (see page 40 for further information on Exchange profiles)

If you are required to enter a password when opening MS Exchange, type this into the MAPI Password field. Otherwise please leave this field blank.

If you are running Windows for Workgroups enter your standard MS Mail login and password.

Click OK and log out of OfficeTalk. 

Log back into OfficeTalk and you are now ready to send and receive Internet E-Mail.



If you receive an error message logging on to MAPI, please request our MAPI Password Fax.



There are three methods of sending E-Mail from OfficeTalk.



Method A - The Contact List 



This allows you to send E-Mail to contacts that have been entered in the OfficeTalk Contact Mode.



View the Send To list.

Double click on the � EMBED PaintShopPro  ��� icon. 

This displays the Contacts which have E-Mail addresses defined within Contact Mode.

Double click on the contact to add the contact to the Recipient List. 

If you wish to send the message as either a carbon copy (cc), or a blind carbon copy (bcc), highlight the contact once and press either the � EMBED PaintShopPro  ��� or the � EMBED PaintShopPro  ��� button.
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To add a contacts E-Mail address; 



Go to Contact Mode and select the appropriate contact. 

Double click on the contact and Contact dialog box will appear. 

Enter the E-Mail address into the E-Mail field and select MAPI from the drop down list.

Press OK and the E-Mail address will be added to the database, this then will be available to all OfficeTalk users.

The contacts E-Mail address will appear in the Recipient List as � EMBED PaintShopPro  ���.



Method B - The Address Recipient dialog box



This dialog box allows you to enter E-Mail addresses that you do not wish to store. To enter an address;

1. Press the � EMBED PaintShopPro  ��� button (right of the word Recipient). The following dialog box will appear:
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Address Recipient dialog box



Enter the contacts name, E-Mail address and ensure that type is set to MAPI.

Click OK. The E-Mail address will appear in the recipient list as � EMBED PaintShopPro  ���.



Method C - The MAPI Address Book



The MAPI address book is the address book supplied with Microsoft Mail or Microsoft Exchange. The address book is private to the individual OfficeTalk user and cannot be accessed by other users.

 

To access the MAPI address book double click on the � EMBED PaintShopPro  ���located at the bottom of the OfficeTalk Send To list. 

Select the person you wish to send the E-Mail to and press OK. 

The E-Mail address will appear in the recipient list as � EMBED PaintShopPro  ���.



Note: When you send mail, OfficeTalk will attempt to check the given address against the MAPI address book. If you send an E-Mail to John Smith and there is a different John Smith in your MAPI address book, OfficeTalk will send the E-Mail to the John Smith in your MAPI address book. If this is a potential problem for your organisation you should keep all your E-Mail addresses in the OfficeTalk address book and leave the MAPI address book blank.





To add a new contact to your MAPI address book;



Double click on the � EMBED PaintShopPro  ���icon from the Send To list. This will display the MAPI Address book dialog box.

Click New.

This will display the new entry dialog box. Select the Other Address option and click OK.

Enter the appropriate name and E-Mail address. Click OK.
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To help you get the most out of OfficeTalk, we have listed below the most frequently asked questions and the answers to them.

How do I stop OfficeTalk from asking me ‘Are you sure you wish to close OfficeTalk ‘ every time I exit? 



By specifying the line:



promptOnLogOff=0



in the Options section of the OTALK.INI located in the Windows directory.



How do I import data from an existing database into OfficeTalk?



OfficeTalk lets you import company records from Comma Separated Values (.CSV) files. A typical CSV file format is shown in the table below:



"Name",�"Address1",�"Address2",�"Town",�"Postcode"��"Softalk Ltd",�"1 May Sq",�"Hurley St",�"Aylesford",�"HP17 7DD"��"DSA",�"Bydell Hse"�"Sudbury Hill",�"Harrow",�"HA1 3NJ"��"Acme Ltd",�"Acme Rd",�"Acme Hill",�"London",�"SE1"��"Intera Ltd",�"Chiltern Hs",�"45 Stn Road",�"Henley",�"RG9 1AT"��"PPG",�"1 Pit Way",�"Murray Rd",�"Staines",�"ST1 1DR"��

CSV File Format



The first line in a CSV file is called the header line and this must always be present. The header defines the field names of the CSV file. The following lines are individual company records. Most database packages will provide a CSV format output of their data. Once you have a file in this format, you may import the data into OfficeTalk in the following way:



If you have a CSV file which contains both company and contact information in the same record, then you should perform two imports; firstly import the company information, and then, using the same CSV file, import the contact information.



Firstly, select Import CSV Records from the File menu within Contact mode.



















�
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The Import CSV Records Command



A CSV Import dialog box will appear:
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CSV Import dialog box



1.	Select the CSV file containing the data that you wish to import. You can do this by pressing the � button and selecting the file from the File dialog box.

2.	Ensure that Company is selected in the Import Type pull down list. Note that if you wish all the imported companies to be visible only to you then select Personal Company from the Import Type pull down list.

3.	The OfficeTalk Fields list will contain the available fields in a company record. The Available Fields list will contain a list of fields found in the CSV file. You can connect the CSV file fields to OfficeTalk fields by selecting an item from each list and pressing the � button. The connection will appear in the Connections list at the bottom of the dialog box. 

4.	If the CSV file has quoted fields (every field is enclosed by a pair of “ ” characters) then ensure that the Quoted Fields check box is checked. Sometimes fields are separated by TAB characters instead of commas. If this is true ensure that Tab is selected from the Delimiter pull down list.
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5.	Press the � button. OfficeTalk will begin importing the records. A Percentage window will appear informing you of the progress of the import. You can cancel the import at any time by pressing the Cancel button on the percentage window.



If a company/contact group is currently selected, then the Import into current group check box will be enabled. If you check this box, OfficeTalk will import the data and will automatically put each record into the currently selected group.



Note: Importing companies does just that, it does not import contact information. If you have a CSV file containing both company and contact information then you must firstly import the companies and then import the contacts using the same CSV file. For details on how to do this, see below.





To import your contact records follow steps 1-5 above ensuring that Contact is selected in the Import Type pull down list. If you wish all the imported contacts to be visible only to you then select Personal Contact from Import Type pull down list.



If you have a CSV file which contains both company and contact information in the same record, then you should perform two imports; firstly import the company information, as described above, and then, using the same CSV file, import the contact information, but ensuring that the [Company] field in the OfficeTalk Fields list is connected to the field representing the name of the company in the Available Fields list. OfficeTalk will then be able to associate all the contacts with the relevant companies.



Will I get duplicate records when I import data?



When OfficeTalk imports companies, a check is performed every time a record is about to be added to ensure that a similar company record does not already exist. For example, if a company Lanworth Ltd, for instance, is about to be imported from the CSV file, OfficeTalk will check to ensure that the company record for Lanworth Ltd does not already exist. If it does, OfficeTalk will not add the new record, but will instead store the record in a list which it will present at the end of the CSV import. The list will appear in a window as shown below:



� EMBED Word.Picture.6  ���



Repeated Companies dialog box





�

I imported my CSV files incorrectly, can I delete them quickly?



OfficeTalk allows users to delete either the whole database or just the current contact group. To delete a contact group ensure that the correct contact group is selected. To delete all the companies in the group use the Edit\Company\Delete All Companies and to delete all the contacts in a group use Edit\Company\Delete All Contacts. 



OfficeTalk will then ask you if you wish to Delete All Companies\Contacts. If you do, press OK. 



OfficeTalk will now prompt you to confirm the deletion by typing your password into the Signature dialog box:
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Signature dialog box



OfficeTalk will then present you with a final dialog box asking you to confirm the deletion. To delete all records from a contact group you will need to perform the procedure twice, the first time to delete all the companies and the second time to delete all the contacts.



If users wish to delete their whole contact database they should make sure that there are no contact groups selected and then perform the procedures described above.



How do I assign diary access rights?



In order to demonstrate how to set up diary access rights, consider the example of a Managing Director and his Personal Assistant who requires full access to his diary.



Select Supervisor mode - Any changes to diary access rights must be performed by a user designated as a Supervisor.

From the user list select the Managing Director’s user record by single clicking the mouse button.

Edit his user details by either double clicking on the user name or selecting the pencil (edit) icon located above the user list.

Click on the Access Rights button � EMBED PaintShopPro  ��� located on the User Details dialog box.

Select the Personal Assistant's name from the Access Of user list within the Access Rights dialog box that has appeared.





�

Select the appropriate access level from the set of options located to the right of the user list, in this case it would be Read, Create, Edit, Delete Access.

Click the OK button on the Access Rights dialog box.

Click the OK button on the User Details dialog box.
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Access Rights dialog box





How do I deinstall OfficeTalk?



Deinstallation can be achieved by deleting the following items:-



Any directory in which OfficeTalk has been installed, or on network client machines, any directory in which the OfficeTalk executables reside (e.g. C:\OTALK).

The files otalk.ini and WBTRCALL.DLL ( please check with your network supervisor, that no other applications are using this file) located within the directory containing MS Windows.  These must be removed from any machine that has been accessing OfficeTalk (eg.C:\WINDOWS).





I’m using a HP Laserjet and when printing out my Task List the last letter in my surname is cut off.



This is caused by a bug in the Laserjet printer drives. To stop this from occurring go to the Supervisor mode and double click on the users name. In the � EMBED PaintShopPro  ��� box, place the cursor after the users surname and press the spacebar once. When you print the task list out the surname will now be printed correctly.





How do I import Lotus Organiser address files?



When you export the address files from Lotus Organiser as a CSV file, press the Options button � EMBED PaintShopPro  ��� and ensure that the Field Name the in First Record box is crossed. � EMBED PaintShopPro  ��� Press the Map All button � EMBED PaintShopPro  ��� when Organiser asks you how you would map your information.�

To import company and contact addresses into OfficeTalk requires two imports. From the Contact mode go to File\Import. The default will be for Quoted Fields and Comma delimited which doesn't need to be touched. Use the Browse button to locate your file. 

The import type should be Company. Match Lotus Organiser Company_Name field to Company Name by highlighting each one and pressing Connect. To import address fields match the Lotus Organiser address field to Address 1.

Lotus Organiser uses hard returns to space out its address field. OfficeTalk will locate these and place the addresses into the next available address line. Therefore if a Lotus address file has two address lines and a city it will match perfectly with OfficeTalks’. 

Once all fields have been matched, import the file. This will now import the company details. Once this is complete, choose contact as the import type and match the appropriate fields. Ensure that the Lotus Organiser Company_Name field is matched to [company]. 
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OfficeTalk CSV Import dialog box



How do I see just my conversations in Contact Mode ?

OfficeTalk now adds three conversation filters to all new users added to the system. The filters are:



My Conversations

Current Company conversations

3. Current Contact conversations



The Current Company conversation is applied as default for all new users.
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The My Conversations filter shows only conversations created by the user. The Current Company filter shows conversations created by any user with the currently selected company in Company view in Contact mode. The Current Contact  filter shows conversations created by any user with the currently selected contact in Contact view in Contact mode.



How do I connect OfficeTalk to Microsoft Mail or Lotus cc:Mail?



In order to send or receive a message via an external messaging system such as MAPI or VIM, you must be logged into that messaging system. OfficeTalk lets you automatically log into MAPI and/or 

VIM messaging systems on starting up OfficeTalk. You can do this by selecting External Mail from the Options menu. An External Mail dialog box will appear. 
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External Mail Information dialog box



Check the Turn on MAPI Support and/or the Turn on VIM Support check box(es). Specify a login name and password for each of the services. If you do not supply a login name or password for any of the enabled mail services, OfficeTalk will prompt you for this information every time you log in. The MAPI service will cause OfficeTalk to pop up a MAPI Login dialog box. The VIM service will cause OfficeTalk to pop up a VIM Login dialog box.



If OfficeTalk cannot find the VIM database path, which is usually specified in WMAIL.INI in the CC1DIR directory of a cc:Mail installation, then OfficeTalk will prompt for the database path each time you start up OfficeTalk. Type in the path and press OK. If this dialog box continues to appear, see your cc:Mail administrator who should be able to correct the problem.



If you use the MAPI service, you must be running Windows 3.11 or above and you must have the MAPI.DLL file in the path. It will usually live in the WINDOWS or WINDOWS\SYSTEM directory. If you use the VIM service, you will need all the VIM based DLLs which come with cc:Mail. These are as follows:
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DLLs required to be in the path when using the VIM messaging system with OfficeTalk.�	VIM.DLL

	CHARSET.DLL

	MAILENG.DLL

	MEMMAN.DLL��

			Required DLLs for VIM



The VIM DLLs will either be found in your WINDOWS directory or in the cc:Mail directory. If you do not have the listed DLLs then contact your E-Mail suppliers. 





OfficeTalk does not recognise my MAPI login under Windows 95.



In Windows 95, Microsoft Mail has now been integrated into Microsoft Exchange. Your existing  Microsoft login and password which had been entered into the External Mail dialog box will not be recognised by Microsoft Exchange. To send mail to and from Microsoft Exchange, enter MS Exchange Settings into the MAPI login section and delete your existing password.





� EMBED PaintShopPro  ���



External Mail dialog box



You will now be able to use your MS Mail address book via MS Exchange. If OfficeTalk informs you during the login procedure that your password failed, check that your External Mail dialog is identical to the one above. If you still get a message telling you that the password has failed, go to your Control Panel in Windows 95 and double click on the Mail and Fax Icon.



The Microsoft Exchange Profiles dialog box will appear. Press the � EMBED PaintShopPro  ��� button and the following dialog box will appear :
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Microsoft Exchange Profiles dialog box



This lists all your MS Exchange profiles. If you changed the default Exchange profile from MS Exchange Setting please type this into the External Mail box as your MAPI login.







If I’ve categorised the data in my current database, do I need to do it again in OfficeTalk when I import the data?



To ensure that the data is catergorised correctly, create a contact group in Contact Mode using the Edit\Contact Group  pull down menu by using Ctrl-G. Before importing the data use the Select Contact Group dialog box by pressing the Select Contact Group Icon � EMBED PaintShopPro  ���.



When you import the CSV files ensure that the � EMBED PaintShopPro  ��� is checked.





How do I export mail merge files from OfficeTalk?



OfficeTalk allows you to export company and contact records as mailmerge files. Users can either export Company CSV Records which will just export the company names or export Contact CSV Records  which will export both the company and contact names. Both of these options are available in Contact mode through the File menu.



Before you export the CSV file, you should check what type of file your word processor can import. For example Lotus AmiPro can only import comma delimited files whereas Microsoft Word 6 can import both comma and tab delimited files.



Users should check whether fields should be quoted i.e. “Company”, “Address1”, or unquote Company,Address,

 

Users should check whether the delimiter which separates the fields is a comma or a tab i.e. “Company”, “Address1”, or “Company”	“Address1”.





� EMBED PaintShopPro  ���



CSV Output dialog box.



Some wordprocessors may not accept files with a CSV extension. Check in your word processor Help file to ascertain which types of files it can import. When you type a filename into the File you can change the extension to the type you require.





I can’t connect my computer at home to the computer in the office, but I would like to use OfficeTalk remotely.



Install a copy of OfficeTalk on your remote machine but do not run.

On your office machine use the Edit\Work Remote and choose c:\otremote as the directory.

In the Disconnect Options dialog box decide which parts of OfficeTalk you wish to take with you and ensure that the � EMBED PaintShopPro  ��� is uncrossed.

Copy the WBTRCALL.DLL and the OTALK.INI into the c:\otremote directory.

There are several ways of transferring the data between the office and notebook. You could use products such as Laplink (from Travelling Software) to transfer information over a parallel cable.

If the user cannot physically connect the machines then they should copy the information onto a floppy drive. As the information is unlikely to fit onto one 1.44mb floppy disk you will need to 

use programs such as Microsoft Backup or PKZIP to compress the information onto a series of disks. Please note if you are using PKZIP you will need to recurse the directories otherwise the information will be unusable.

On the remote machine decompress the information. You should now have a directory called otremote. You will need to copy both the WBTRCALL.DLL and the OTALK.INI files into the remote machines Windows directory.

Double clicking on the OfficeTalk icon will bring up the remote session.

When you have finished your remote session log out of OfficeTalk.

Copy the c:\windows\otalk.ini file back into the remote c:\otremote directory.

Compress the c:\otremote directory.

On the main machine decompress the otremote directory and replace the original.

Copy the c:\otremote\otalk.ini file and copy it into the c:\windows directory.

Fire up OfficeTalk and choose the File\WorkOnline. 

OfficeTalk will now update the main database.



You will need to perform steps 2-15 each time you work remote. However you will not need to copy the file WBTRCALL.DLL  in steps 4 and 7 after you have done it the first time. This process �

can also be performed over a modem. For more information and ask for our “Using OfficeTalk with Remote Access Software” helpsheet.



Can I customise OfficeTalk’s address fields for non UK addresses?

An external file addr_fmt.dat can be used to change the vocabulary related to address field naming. For example, for the USA it is now possible to change Town/City, County and Postcode to Town, State and Zip respectively. It is also possible to populate the County pull down and the Country pull down. The format for the file addr_fmt.dat is as follows:



Address3 Replacement String

Town/City Replacement String

County Replacement String

Postcode Replacement String

County 1

County 2

County 3

      etc

County n

:

Country 1

Country 2

Country3



The four replacement strings are followed by the first of a list of counties. A colon then signals the end of the list of counties and the start of a list of countries.



OfficeTalk is shipped with two additional files which contain the correct address formats for Denmark and for North America. The American file also contains a complete list of American states which can be accessed via the drop down list in the state field.



To use the American or Danish address formats;



Locate the file ADDR_FMT DAT in your OfficeTalk root directory.

Rename the file to ADDR_FMT.OLD.

Copy either the ADDR_DMK DAT (Danish) or ADDR_USA DAT (American) into your OfficeTalk root directory from Disk 2 of the OfficeTalk Setup Program or from the OTALK directory on the CD ROM.

Rename the copied file to ADDR_FMT DAT.

Log into OfficeTalk and check that the new address format is correct.

If it is correct delete the ADDR_FMT.OLD. If it is not, load the new ADDR_FMT DAT into Windows Notepad and edit the file. 





�

Support



Online Help is available throughout all the modes in OfficeTalk. If you have tried all the Help Files and you still have further questions please contact our support team by phone, fax or E-Mail.



Once you register your copy of OfficeTalk, your period of free support will end. To continue using this support, a charge equivalent to 10% of your total software cost (minimum £70.00 p.a. plus VAT) is made, payable on an annual basis. Single user support is charged at £35.00 p.a. plus VAT.



When asking for Technical Support please have these details available:



Your Reference Number (44 -     ).

Type of Computer you are using.

The network you are using.

What action you were performing in OfficeTalk when the problem occurred.

Are you able to replicate the problem?

Any error messages that have appeared.



Phone us on 0181 423 9434 and ask for Technical Support.



Fax us on 0181 423 9438.



E-Mail us over the Internet on otsupport@sareen.com



Visit our web site at http://www.sareen.com



CompuServe Mail us on 70630,2351 



Visit our CompuServe Forum - Go Sareen



Training and Seminars



Many of our customers are benefiting from training. We run courses both here at Bydell House and on-site at our customer’s premises, dependent on the requirement. Please call our Customer Service Team on 0181 423 9434 or fax us on 0181 423 9438.



Manuals



The full OfficeTalk manual is available for just £8.50.
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